Content

Content............................................................................................................................2
Preface...............................................................................................................................3
Introduction.......................................................................................................................4
Notice...............................................................................................................................5
Chapter 1: 3D Printing Technology..................................................................................8
Chapter 2: About Inventor 2S.........................................................................................10
  2.1 About Your Inventor 2S.......................................................................................10
Chapter 3: Unpacking......................................................................................................23
Chapter 4: Hardware Assembly......................................................................................27
  4.1 Filament Installation............................................................................................27
  4.2 Printer Start-up...................................................................................................28
  4.3 Loading Filament...............................................................................................28
  4.4 Unloading Filament............................................................................................30
Chapter 5: Build Plate Leveling....................................................................................32
Chapter 6: About Software...........................................................................................34
  6.1 Software Installation..........................................................................................34
  6.2 Exploring FlashPrint.........................................................................................34
Chapter 7: Basic Printing..............................................................................................58
  7.1 Generate a Gcode.............................................................................................58
  7.2 Print Methods...................................................................................................60
  7.3 Camera.............................................................................................................73
Chapter 8: Supports and Service...................................................................................74
Preface

Note: Each device must be tested before leaving factory. If there are some residues in extruder or some tiny scratches on the build tape, it is normal and won’t affect the printing quality.

On the completion of this User Guide, thanks all FlashForge engineers and the FlashForge 3D printer users for their unremitting efforts and sincere assistance.

The FlashForge Inventor 2S User Guide is designed for the Inventor 2S users to start their printing journey with FlashForge Inventor 2S. Even if you are familiar with earlier FlashForge machines or 3D printing technology, we still recommend that please read this guide, as there is lots of important information about the Inventor 2S for you to get a better 3D experience.

For a better and more successful printing experience, you can refer to the following materials:

(1) Quick Start Guide:

Users will find the Quick Start Guide together with the printer accessories. The Quick Start Guide will help you start your print journey as soon as possible.

(2) Official FlashForge Website:

The official FlashForge website contains the up-to-date information concerning FlashForge software, firmware, device maintenance and so on. Users are also able to get the contact information from there.
Introduction

Notes:

- Please read FlashForge Inventor 2S 3D Printer User Guide carefully before use.
- The User Guide is written based on Windows 7 OS.
- The version of the FlashPrint is latest.

The FlashForge Inventor 2S 3D Printer User Guide contains the information needed for you to set up and use this device.

This User Guide including the following parts: Preface, Introduction and After-sale service.

The Preface section includes resource acquisition channel, the overall framework of the manual, and the problems that should be paid attention to while printing.

The introduction section contains the overview of 3D printing technology, equipment introduction, unpacking and installation of equipment, software installation and usage. After-sale section contains the user how to get the support and help.
Notice

Safety Notice

! Notices: Read all the instructions in the manual and familiarize yourself with the FlashForge Inventor 2S User Guide before setting-up and using. Failure to comply with the warning and instructions may result in individual injury, fire, equipment damage or property damage.

PLEASE STRICTLY FOLLOW ALL THE SAFETY WARNINGS AND NOTICE BELOW ALL THE TIME.

▪ Work Environment Safety
  ① Keep your work place tidy.
  ② Do not operate Inventor 2S in the presence of flammable liquids, gases or dust.
  ③ Keep Inventor 2S out of children and untrained people’s reach.

▪ Electrical Safety
  ① Always use the Inventor 2S with a properly grounded outlet. Do not refit Inventor 2S plug.
  ② Do not use Inventor 2S in damp or wet locations. Do not expose Inventor 2S to burning sun.
  ③ In case of device damage, please use the power supply provided by FlashForge.
  ④ Avoid using the device during an thunderstorm.
  ⑤ In case of uncertain accident, please unplug the device if you do not use it for long.

▪ Personal Safety
  ① Do not touch the nozzle and build plate during printing.
  ② Do not touch the nozzle after finishing printing.
③ Dress properly. Do not wear loose clothing or jewelry. Keep your hair, clothing and gloves away from moving parts.
④ Do not operate the device while you are tired or under the influence of drugs, alcohol or medication.

- **Cautions**
  ① Do not leave the device unattended for long.
  ② Do not make any modifications to the device.
  ③ To lower the build plate before loading/unloading filament. (The distance between the nozzle and build plate should be kept for at least 50mm)
  ④ Operate the device in a well-ventilated environment.
  ⑤ Never use the device for illegal activities.
  ⑥ Never use the device to make any food storage vessels.
  ⑦ Never use the device to make any electrical appliance.
  ⑧ Never put the model into your mouth.
  ⑨ Do not remove the models with force.

- **Environment Requirements**
  Temperature: RT 15-30°C
  Moisture: 20%-70%

- **Place Requirements**
  The device must be placed in a dry and ventilated environment. The distances of the left, right and back side space should be at least 20cm, and the distance of the front side space should be at least 35 cm.
- **Filament Requirements**
  Do not abuse the filament. Please make sure you use the FlashForge filament or the filament from the brands accepted by FlashForge.

- **Filament Storage**
  All polymers degrade with time. Do not unpack filament until necessary. Filament should be stored at clean and dry conditions.

**Legal Notice**

All the information in this document is subject to any amendment or change without the official authorization from FlashForge.

FLASHFORGE CORPORATION MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS DOCUMENT, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

FlashForge shall not be liable for errors contained herein for incidental consequential damages in connection with furnishing, performance or use of this material.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This document contains proprietary information protected by copyright.

Copyright © 2017 FlashForge Corp. All Rights Reserved
Chapter 1: 3D Printing Technology

3D printing refers to transforming three-dimensional models into physical objects that you can hold and touch. It is also called additive manufacturing because the 3D model is created by “adding” layers upon layers of material until the object is fully formed.

Fused Filament Fabrication (FFF) is the most common method of 3D printing. It is also the method that the Inventor 2S uses. It works by melting plastic material called filament onto a print surface in high temperature. The filament solidifies after it cools down, which happens instantaneously after it is extruded from the nozzle. 3D objects are formed with the filament laying down multiple layers.

1.1 Process
3D printing involves three steps:
1.) Make or download a 3D model
2.) Slice and export the 3D model
3.) Build the 3D model

1.1.1 Make a 3D Model:
Currently, there are three ways to creating a 3D model.

- Designing From Scratch You can use free CAD (computer-aided design) software, such as 3DTADA, AutoCAD, SolidWorks, Pro-E, and our own software Happy 3D to design your own 3D model.

- 3D Scanners An alternative method to creating a 3D model is to scan an object. 3D scanners work by digitizing a physical object, collecting its geometric data, and saving it to a file on your PC. There are also apps that can turn a mobile device into a 3D scanner.
·From the Cloud The most popular way of obtaining a 3D model is to download it from websites that allow users to upload 3D models that they designed.
E.g. : www.thingiverse.com

1.1.2 Slice and Export the 3D Model:
Slice software is the software that prepares 3D models for printing and turns them into instructions for the 3D printers. FlashPrint is the slicing software used for the FlashForge Inventor 2S.

Using FlashPrint, you can turn .stl files into .g or .gx files for printing. Then the files can be transferred to your Inventor 2S via USB cable, USB stick or Wi-Fi.

1.1.3 Build the 3D Model:
Once the output file has been transferred to your Inventor 2S, it will start to turn the 3D model into a physical object by laying down layers of filament.

1.1.4 Basic 3D Printing Process:

<table>
<thead>
<tr>
<th>First Print</th>
<th>Daily Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install printer</td>
<td>Print model</td>
</tr>
<tr>
<td>Printer Unboxing</td>
<td>Acquire model</td>
</tr>
<tr>
<td>Accessories check</td>
<td>Load in model</td>
</tr>
<tr>
<td>Filament Loading</td>
<td>Adjust model</td>
</tr>
<tr>
<td>Install software</td>
<td>Set printing parameters</td>
</tr>
<tr>
<td>Install software</td>
<td>Distribute print jobs</td>
</tr>
<tr>
<td>Start software</td>
<td>After print Processing</td>
</tr>
<tr>
<td></td>
<td>Take down model</td>
</tr>
<tr>
<td></td>
<td>Remove supports</td>
</tr>
</tbody>
</table>

www.flashforge-usa.com
Chapter 2: About Inventor 2S

2.1 About Your Inventor 2S

2.1.1 Views

1) Touch screen
2) Touch screen button
3) Nozzle
4) Z-axis guide rod
5) Build plate

1) Leveling knob
2) Filament cartridge
3) Extruder
4) Filament intake
5) X-axis guide rod

1) Spring presser
2) Camera
3) USB cable input
4) USB stick input
5) Power input
6) Power switch
### 2.1.2 Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build Plate</strong></td>
<td>The surface on which the Inventor 2S builds an object. Inventor 2S has an extracting magnet build plate, which is composed of 3 parts: build tape, flexible metal sheet and magnetic patch. It is convenient for users to take down the model, and can be used directly as operating platform for processing model result.</td>
</tr>
<tr>
<td><strong>Build Tape</strong></td>
<td>The blue tape that covers Inventor 2S build plate so that the object can stick to the build plate well.</td>
</tr>
<tr>
<td><strong>Build Volume</strong></td>
<td>The three dimensional amount of space that an object will use once it is completed. The largest build volume of Inventor 2S is 150×140×140mm.</td>
</tr>
<tr>
<td><strong>Leveling Knobs</strong></td>
<td>Knobs under the build platform that are used for adjusting the distance between the nozzle and build plate.</td>
</tr>
<tr>
<td><strong>Extruder</strong></td>
<td>The device that draws the filament from the spool, melts it and pushes it through a nozzle into the build plate.</td>
</tr>
<tr>
<td><strong>Nozzle</strong></td>
<td>Also called “print head”, which located at the bottom of the extruder where heated filament is squeezed out.</td>
</tr>
<tr>
<td><strong>Cooling Fan</strong></td>
<td>To cool the outer assembly of the extruder and gear motor.</td>
</tr>
<tr>
<td><strong>Filament Intake</strong></td>
<td>An opening located at the top of the extruder.</td>
</tr>
<tr>
<td><strong>Filament Guide Tube</strong></td>
<td>A black plastic piece that guides the filament from the filament box to the filament intake.</td>
</tr>
<tr>
<td><strong>Filament Cartridge</strong></td>
<td>A specific box for placing FlashForge filament.</td>
</tr>
<tr>
<td><strong>Solid Glue Stick</strong></td>
<td>A solid adhesive used for making the model stick to the build plate firmly.</td>
</tr>
<tr>
<td><strong>Unclogging Pin Tool</strong></td>
<td>A tool that used for cleaning and unclogging the extruder.</td>
</tr>
<tr>
<td><strong>Stamping Wrench</strong></td>
<td>A tool that used for seizing the nozzle’s metal cube.</td>
</tr>
</tbody>
</table>
### 2.1.3 Reference

<table>
<thead>
<tr>
<th>Name</th>
<th>Inventor 2S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Extruder</td>
<td>1</td>
</tr>
<tr>
<td>Print Technology</td>
<td>Fused Filament Fabrication(FFF)</td>
</tr>
<tr>
<td>Screen Size</td>
<td>3.5” color IPS Touch Screen</td>
</tr>
<tr>
<td>Build Volume</td>
<td>150×140×140mm</td>
</tr>
<tr>
<td>Layer Resolution</td>
<td>0.1 - 0.4mm</td>
</tr>
<tr>
<td>Build Accuracy</td>
<td>±0.1mm</td>
</tr>
<tr>
<td>Positioning Accuracy</td>
<td>Z axis 0.0025mm; XY axis 0.011mm</td>
</tr>
<tr>
<td>Filament Diameter</td>
<td>1.75mm (±0.07)</td>
</tr>
<tr>
<td>Nozzle Diameter</td>
<td>0.4mm</td>
</tr>
<tr>
<td>Build Speed</td>
<td>10~200 mm/s</td>
</tr>
<tr>
<td>Software</td>
<td>FlashPrint</td>
</tr>
<tr>
<td>Support Formats</td>
<td>Input: 3MF/ STL/OBJ/FPP/BMP/PNG/JPG/JPEG</td>
</tr>
<tr>
<td></td>
<td>Output: GX/G</td>
</tr>
<tr>
<td>OS</td>
<td>Win xp/Vista/7/8/10、Mac OS、Linux</td>
</tr>
<tr>
<td>Device Size</td>
<td>420×420×420mm</td>
</tr>
<tr>
<td>Net Weight</td>
<td>11.7Kg</td>
</tr>
<tr>
<td>AC Input</td>
<td>Input: 100V-240VAC, 50-60Hz   Power: 65W</td>
</tr>
<tr>
<td>Connectivity</td>
<td>USB cable, USB stick, WiFi, FlashForge Cloud, Polar Cloud</td>
</tr>
<tr>
<td>Camera</td>
<td>1, Inside the corner between front and left board</td>
</tr>
</tbody>
</table>
## 2.1.4 Interface Menus

<table>
<thead>
<tr>
<th>Build</th>
<th></th>
</tr>
</thead>
</table>
| **Build** | Read the print file from  

- The internal memory  
- The USB stick  
- The Polar Cloud Connection  
- Back |

<table>
<thead>
<tr>
<th>Copy</th>
<th>Delete</th>
<th></th>
</tr>
</thead>
</table>
| **Build**: To begin printing  
**Copy**: To copy the files to the local memory card from the USB stick. (The button is not available while printing from internal memory)  
**Delete**: To delete the print file  
**Back** |  |

<table>
<thead>
<tr>
<th>More</th>
<th></th>
</tr>
</thead>
</table>
| **Abort**: To abort the print job.  
**Pause/Resume**: To suspend or resume the printing job.  
**More**: To check status or modify settings during printing: build time, Z axis, filament used, printing speed, light status, change filament, finish-shutdown.  
**Extruder temperature**: Can be changed during printing. |  |
To set extruder temperature during printing:
After extruder temperature has reached target temperature, temperature figure will be underlined in print interface,
Tap the temperature figure to adjust;
Tap [Yes] to save the setting while tap [No] to cancel the setting.
Temperature adjust range: 180 - 240°C

More in print interface
☞ Printing speed: To change printing speed during printing by tapping the underlined speed figure.
☞ Light bulb: To turn on/off the light.
☞ Filament: To change filament during printing. (Note: You need to suspend the printing operation first)
☞ Finish-Shutdown: To start auto shutdown after print job finished.
☞ Cancel: To end the tool orders and return to the print interface.

To set the printing speed during printing
Tap the speed figure to adjust;
Tap [Yes] to save the setting while tap [No] to cancel the setting.
Printing speed adjust range: 50% - 300%

Preheat
<table>
<thead>
<tr>
<th>Tap the <strong>[Preheat]</strong> button to enter the preheat interface. Tap the <strong>[Start]</strong> button to heat up to the setting temperature. The default temperature is 220℃. Tap the temperature display bar to set the temperature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set the preheat temperature. Tap <strong>[Yes]</strong> to save the setting while tap <strong>[No]</strong> to cancel the setting.</td>
</tr>
<tr>
<td>The picture displays the preheat interface. It shows the actual temperature and the target temperature. Tap the <strong>[Cancel]</strong> button to abort the preheat job.</td>
</tr>
</tbody>
</table>
Tap [Tools] to enter tool options.

- Filament: To load/unload the filament.
- Level: To adjust the build plate.
- Home: To make the X, Y and Z axes back to the zero point.
- Manual: To manually adjust the positions of X, Y and Z axes.
- Setting: To implement relevant function setups.
- Status: The check the real-time status of the printer.
- About: Information about the printer.

Manual adjustment

- Y+: The extruder moves to the zero point, that is, the back of the machine
- Y-: The extruder moves to the direction opposite to the Y+.
- X+: The extruder moves to the zero points, that is, to the right direction
- X-: The extruder moves to the direction opposite to the X+.
- Z+: The build plate elevates.
- Z-: The build plate descends.
Tap [Setting] to enter the setting interface

- **Language**: To set the display language
- **WiFi**: To turn on/off the WiFi
- **WLan hotspot**: To turn on/off the WLan hotspot.
- **Polar Cloud Connection**: To turn on/off the Polar Cloud Connection.
- **FlashForge Cloud Connection**: To turn on/off the FlashForge Cloud Connection.
- **Extruder Calibration**: To adjust the initial distance between the extruder and the build plate.
- **Startup Sound**: To turn on/off the Startup Sound.
- **Filament Check**: To turn on/off the filament check
- **Door Opened Pause**: To turn on/off the function of door pause
- **Power Saving Mode**: To turn on/off the power saving mode.
- **Light Bar Control**: To turn on/off the light bar control.
- **Factory Reset**: Return to factory setting
- **Update**: To update the firmware version.
- **Back**
### WiFi:
- **Turn on WiFi:** Turn on the WiFi, release the WiFi hotspot and set the WiFi on computer
- **Back**

### WLan hotspot
- **OFF/On:** To turn on/off the Wlan hotspot.
- **Setup Wlan hotspot:** To set the SSID and password.
- **SSID:** The name of hotspot.
- **Password:** The password of hotspot.
- **Save:** To save the setting.
- **Back**

### Polar Cloud Connection:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polar Cloud</td>
<td>To turn on/off the polar cloud connection.</td>
</tr>
<tr>
<td>Setup Cloud Connection</td>
<td>To set cloud connection Account and PIN which have already been registered on: <a href="https://polar3d.com">https://polar3d.com</a></td>
</tr>
<tr>
<td>Account</td>
<td>The email address of your Cloud account.</td>
</tr>
<tr>
<td>PIN</td>
<td>The PIN code of your Cloud account.</td>
</tr>
<tr>
<td>Save</td>
<td>To save the setting.</td>
</tr>
<tr>
<td>Back</td>
<td>(Note: To use polar cloud function, you need to connect the printer to internet with WiFi )</td>
</tr>
<tr>
<td>Extruder Calibration</td>
<td>To adjust the initial distance between the extruder and the build plate by tapping [-]and[+]. The proper distance may be one ordinary paper’s thickness. Z: 0.00 stands for the position where the servo is precisely triggered. (Note: Please do this operation after contacting with our after-sale engineer.</td>
</tr>
<tr>
<td>FlashForge Cloud</td>
<td>Tap to turn on/off the FlashForge Cloud Connection.</td>
</tr>
<tr>
<td>Startup Sound</td>
<td>Tap to turn on/off the sound when restart the printer.</td>
</tr>
<tr>
<td>Filament Check</td>
<td>On: The filament detection is turned on. Note: Filament exhausted or interrupted will be detected. Once the filament is not in the right place, the print job can not work normally.</td>
</tr>
</tbody>
</table>
[Filament Check] Off:
The filament detection is turned off.
Note: Filament exhausted or interrupted cannot be detected. The print job can still work normally when filament is not set into the filament cartridge.

[Door Opened Pause] On:
If printer front door is opened during printing, door opened pause hint will pop out on printer touch screen.

[Door Opened Pause] Off:
If printer front door is opened during printing, door opened pause hint will not pop out on printer touch screen.

[Power Saving Mode] On:
The power saving mode status is turned on. If there is no operation within half an hour, the printer will automatically shut down. (Power saving mode will not work in the process of printing)

[Power Saving Mode] Off
The power saving mode status is turned off. Automatically shut down will not work.

Turn on/off [Light Bar Control]:
☞ Tap to turn on/off the light bar.

☞ Factory Reset: Return to factory setting.
☞ Update: To update the firmware version.
☞ Back
| Status: | It displays the real-time status of the extruder temperature, door, filament and original extruder position. |
| About:(First page) | It displays the basic information about the device. |
| About:(Second page) | It displays the basic information about the device. |
| License | It displays the basic information about the license. |
2.2 Accessories

- Filament ×1
- Power Adapter
- Power Cable
- USB Cable
- Filament Guide Tube
- Quick Start Guide
- USB Stick
- Screwdriver
- Allen Wrench
- Solid Glue
- Stamping Wrench
- Unclogging Pin Tool
- Lid
- After-sale Service Card
- PTFE Tube
- Grease
Chapter 3: Unpacking

(reference video: Unpacking)

This chapter will present you the whole unpacking procedure of Inventor 2S 3D printer. (Note: Make sure you read the whole unpacking guide)

3-1

(3-1) Place the packaging box on a clean work surface.

3-2
(3-2) Open the box, grasp the two handles and then lift your Inventor 2S out of the box.

3-3

(3-3) Remove the accessory box, you can see a quick start guide and an after-sales service card, in the box it contains a power adapter, a power cable, glue stick, USB cable, guide tube and accessory bag (USB stick ×1, stamping wrench ×1, unclogging pin tool ×1, and screwdriver ×1 Allen wrenches ×2, Grease and PTFE tube.)

3-4

(3-4) Remove the side protective foam sheets.
(3-5) Remove the bag to unveil the Inventor 2S

(3-6) Remove the top foam sheet

(3-7) Remove the tape on for fixing the flat cable and cut off four ribbons that used for fixing the guide rod. Then slide the extruder to make sure the extruder is in good condition.
(3-8) Slightly squeeze the bottom of the lid, and remove it carefully.

(3-9) Take out left side foam sheet. Elevate the build plate up and then take the bottom foam sheet out.

Congratulations! You have unpacked your Inventor 2S. Next, let’s move on to hardware assembly of Inventor 2S.
Chapter 4: Hardware Assembly

Your Inventor 2S has been installed before leaving factory, you can start up the Inventor 2S for printing after mounting the filament spool and completing leveling.

4.1 Filament Installation

(4-1) The filament cartridge is at the rear of Inventor 2S. Lift the cartridge out of the Inventor 2S.

(4-2) Take out the filament and thread it through the filament detecting equipment. *(Note: The filament should feed from the bottom of the spool towards the top)*

After installing the filament, put the cartridge back to the printer.
4.2 Printer Start-up

(4-3) Insert the power supply into the power input on the back of the Inventor 2S and plug the power cord into an electrical outlet.

4.3 Loading Filament

For stable filament loading and proper device protection, you need to install the filament guide tube properly.

(4-5) Take out the filament guide tube, thread the filament from the filament cartridge through the tube.
(4-6) Insert the filament from the filament guide tube into the filament intake.

Next, we will load the FlashForge filament. **(Note: Please lower the build plate to increase the distance between the nozzle and build plate to 50mm at least for avoiding nozzle jam.)**

(4-7) Tap [Tool].

(4-8) Tap [Filament]—[Load]
After the extruder’s temperature reaching 220℃, the printer will sound a beep to prompt you to load the filament into the extruder.

Insert the filament into the extruder at an upright angle. Then the filament will be drawn through the extruder. Do not tap [Cancel] until the filament load the extruder steadily.

4.4 Unloading Filament

Tap [Tool]-[Unload] and the extruder starts heating up.
(4-12) After the extruder reaching 220°C, the printer will sound a beep to prompt you to unload the filament from the extruder. Press the spring presser, press down the filament for about three seconds and gently pull the filament out.

Note: Do not pull out the filament with force as it will damage the gears. If the melted filament has cooled down in the extruder, please repeat the steps above.
Chapter 5: Build Plate Leveling

Inventor 2S creatively adopts three-point intelligent leveling system, which will give clear and comprehensive feedback to users. There are three spring-loaded knobs under the build platform. The distance between the plate and nozzle increases while tightening the knobs. On the contrary, the distance reduces.

(5-1) Tap [Tools]-[Level] on your Inventor 2S touch screen. Please wait while the extruder and platform finish initial movements. After that, operate according to the guide on the touch screen.
(5-2) After tapping [Yes], the extruder starts to move towards the first point and the plate moves up and down to verify the distance between nozzle and plate.

5-3

(5-3) When it shows that the distance is too big, please unscrew corresponding nut under platform clockwise until hearing a steady beep and the [Verify] button appears.

5-4

(5-4) If the distance is appropriate, tap [OK] to second point leveling. If still not, please follow the prompts to adjust again till you see [OK] button.

5-5

(5-5) Repeat steps 2 through 4 above to complete second and third points leveling and then Tap [Finish] to exit.
Chapter 6: About Software

This chapter talks about the basic function of FlashPrint. For more information about advanced function, you can browse our website www.FlashForge-usa.com.

6.1 Software Installation

6.1.1 Software Acquisition

Method 1: To get the installation package from the USB disk in the toolkit.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Size</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashPrint_3.7.1_win64</td>
<td>41,637 KB</td>
<td>Windows Installation</td>
</tr>
<tr>
<td>FlashPrint_3.7.1_win32</td>
<td>37,995 KB</td>
<td>Windows Installation</td>
</tr>
<tr>
<td>FlashPrint_3.7.1_mac</td>
<td>16,599 KB</td>
<td>compressed file</td>
</tr>
</tbody>
</table>

Method 2: Open the link below to download the installation package:

http://www.FlashForge.com

Steps:

Support - Downloads - FlashPrint - Choose the Software Version - Download

6.1.2 Software Installation and Start-up

1. Decompress the zipped file or start the installation program, and then install the software according to the direction.

2. Click the software icon to start the software with the start menu shortcut.(See 6-1)

6.2 Exploring FlashPrint

6. 2.1 Machine Type Selection
Note! After starting FlashPrint, you need to select the target machine type first. When you start FlashPrint, a dialog box will pop up. Just select FlashForge InventorIIIs in the machine type list and click [OK]. You can also change the machine type via clicking [Print]--[Machine type]. See graphic 6-2:

6.2.2 Software Introduction
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Load files icon" /></td>
<td>Load files.</td>
</tr>
<tr>
<td><img src="image" alt="Enter the support edit mode icon" /></td>
<td>Enter the support edit mode</td>
</tr>
<tr>
<td><img src="image" alt="Print it directly with your Inventor 2S or export to your USB Stick icon" /></td>
<td>Print it directly with your Inventor 2S or export to your USB Stick</td>
</tr>
<tr>
<td><img src="image" alt="View FlashPrint home screen from one of six viewing angles icon" /></td>
<td>View FlashPrint home screen from one of six viewing angles</td>
</tr>
<tr>
<td><img src="image" alt="Move model around on XY-plane; shift+click to move along Z axis icon" /></td>
<td>Move model around on XY-plane; shift+click to move along Z axis</td>
</tr>
<tr>
<td><img src="image" alt="Turn and rotate your model icon" /></td>
<td>Turn and rotate your model</td>
</tr>
<tr>
<td><img src="image" alt="Scale the size of your object icon" /></td>
<td>Scale the size of your object</td>
</tr>
<tr>
<td><img src="image" alt="Cut model into several parts icon" /></td>
<td>Cut model into several parts</td>
</tr>
</tbody>
</table>

### 6.2.3 Loading

You can load a model file or Gcode file into your FlashPrint by the following six methods:

**Method 1:** Click the [Load] icon on the main interface. Then select the object file.

**Method 2:** Select the file for loading and drag the file to the main interface of the software.

**Method 3:** Click [File]--[Load File]. Then select the object file for loading.

**Method 4:** Click [File]--[Examples] to load the example files

**Method 5:** Click [File]--[Recent Files] to load the files opened recently.

**Method 6:** Select and drag the target file to the icon of FlashPrint.
**Note:** .STL, .OBJ, and .FPP, ways to store 3D models, are supported by FlashPrint for editing.

**Generating Rilievo**

Load a png, jpg, jpeg, bmp picture file into the FlashPrint. And the following dialogue box (6-3) will pop up. The setting box includes settings for shape, mode, maximum thickness, base thickness, bottom thickness, width, height, top diameter and bottom diameter.

Shape: including plane, tube, canister and lamp.

Mode: including “darker is higher” and “lighter is higher”.

Maximum thickness: Z value of the model

Base thickness: The minimum raft thickness and the default value is 0.5mm

Width: X value of the model

Depth: Y value of the model

Bottom thickness: For tube, canister and lamp to set up bottom thickness

Top diameter: For tube, canister lamp and seal to set up the top diameter

Bottom diameter: For tube, canister, lamp and seal to set up the bottom diameter
Plane (6-5)

Tube (6-6)

Canister (6-7)
6.2.4 Views

① Changing views
Change model views by moving, rotating, scaling.

- Drag
Click the [View] icon and then you can move the object by the following three methods:

**Method 1:** Hold down the left mouse button and drag.

**Method 2:** Hold down the mouse wheel and scroll up and down.
Method 3: Hold down the Shift key, hold down the right mouse button and drag.

- **Rotate**
  Click the [View] icon and then you can rotate the object by the following two methods:
  
  Method 1. Hold down the right mouse button and drag.
  Method 2. Hold down the Shift key, hold down the left mouse button and drag.

- **Scale**
  Rotate the mouse wheel to enlarge or shrink the build plate.

②Set View

Allow users to view the object on the build plate. There are six views are under the view menu, that is, home view, bottom view, top view, front view, back view, left view and right view.

Method 1: Click the the [View] button, there are six views in the drop-down list
Method 2: Click the the [Look] icon on the left, click it again and a submenu will appear with six views for selecting.

③Reset View

Allow users to reset views by the following two methods:

Method 1: Click the [View] menu and select [Home View]
Method 2: Click the [View] button on the left, click it again and you will see the viewing options, you can click [Reset].

④Show Model Outline

Click [View]---[Show Model Outline], it will highlight the yellow border of the object
6.2.5 Move

Select the object and move the object by the following two methods:

**Method 1:** Click the [Move] icon on the left, hold down the left mouse button and drag to adjust the location of the model in XY direction. Hold down the **Shift** key, hold down the left mouse button and drag to adjust the location of the model in Z direction. The distance and the direction of the movement shall be displayed.

**Method 2:** Click the [Move] button on the left and then enter the distance value. Click [Reset] to reset distance values.

**Note:** Users shall click [Center] and [On Platform] after the location adjustment to ensure the model(s) be within the build area and on the build platform. If a specified position is needed, only click [On Platform].

6.2.6 Rotate

Select the target object and rotate the object by the following two methods:

**Method 1:** Click the [Rotate] icon on the left and three mutually perpendicular rings appear around the object Click one ring and rotate on the present axis, you will see the rotation angle and direction in the center of circle. In this way, you could make the model rotate on X/Y/Z axis.

**Method 2:** Click the [Rotate] icon on the left, and then enter into rotating angel values in X/Y/Z axes positioning. Click [Reset] to reset rotating angel values.
6.2.7 Scale
Select the target object and scale the object by the following two methods:
Method 1: Click the [Scale] icon on the left, hold down the left mouse button and scale the model. The corresponding values will display near the object.
Method 2: Click the [Scale] icon on the left and then enter into scale values in X/Y/Z axes positioning. Click the [Maximum] button to get largest size possible for building. Click [Reset] to reset the size of model.
Note: If the [Uniform Scaling] radio button is clicked, it will scale the model in equal proportion when changing value in any positioning of the model. Otherwise it will only change the value of the corresponding positioning.

6.2.8 Cut
Left-click on the model to select it and double-click on the [Cut] icon to set the cut plane. The direction and position are available for setting.
① Draw with Mouse
② X Plane
③ Y Plane

④ Z Plane

6.2.9 Supports

After loading the model, click [Edit]→[Supports] or click the Supports icon directly, then you will enter the support edit modem (as shown in the picture below). Click [Back] to exit when you finish editing.
① Support Options
Click the Support Options, an option box will appear, supports options include “treelike” and “linear”, when choose “treelike”, click [OK], then it will generate treelike structure; when choose “linear”, click [OK], then it will generate linear structure; if it is a model with supports, when you choose one of the supports options, software will judge whether existing supports need to be deleted or not on the basis of the type of existing support, and will pop up the corresponding prompt to let you make the choice.

② Auto Supports
Click the [Auto Supports] button, the software will judge the position where supports are needed and generate corresponding treelike or linear supports. If it is a model with supports, the existing supports will be deleted and new supports will be generated.

③ Add Supports
Supports will be added once clicking the [Add] button. Move the cursor to the position where supports needed, left-click to choose the starting point of supports, hold down the left mouse button and drag the mouse the supports preview will show up (if support surface doesn’t need support or the support column angle is too large, will highlight the support review). Loosen the left mouse button, if support column doesn’t
meet with model, then support will be generated on origin and terminal point (the highlighted preview support won’t generate support structure)

④ Clear Supports

Click [Clear Supports], all supports will be deleted. The operation can be repealed via clicking [Undo] or pressing the shortcut key Ctrl+Z.

⑤ Delete Supports

Supports will be deleted once clicking the [Delete] button. Move the cursor to the supports needed deleting, current supports and its subnode support will be highlighted, click the left mouse button to delete these highlighted support.

6.2.10 Print

① Preview: Choose to enter preview interface or not
② **Print when slice done:** Print or not when slice done

③ **Material type:** Choose according to the type of model

④ **Supports:** When print suspended structure models, support is necessary. Click [supports] to create support part for the printing.

⑤ **Raft:** This function will help the model to stick well on the platform.

⑥ **Wall:** During dual color printing, this function will help to clear the leaking filament of another extruder.

⑦ **Brim:** Expand the outline of model’s bottom layers to a Brim which helps anchor the edges of the model to the plate to avoid warping.

⑧ **Resolution:** You have three resolution solutions (with default setting) to choose from, high resolution is corresponding with slow printing speed, opposite for the low resolution. For PLA printing, an extra solution “Hyper” is available.

⑨ **More options:** Click [More options] to set for layer, shell, infill, speed and temperature. Different resolution solution is corresponding to different defaults, click [Restore Defaults] to back to default setting.

  • **Layer**
    
    a. **Layer:** Layer thickness of the printing model. With a small value, the surface of the model will be smoother.
    
    b. **First Layer Height:** This is the first layer of the model, which will affect the sticking performance between the model and platform. Maximum is 0.4mm, usually the default is ok.
    
    c. **Shell:** Contains the outside shell value, capping layer value (under vase pattern, top solid layer setting is invalid.)

  • **Perimeter Shells:** Maximum is 10

    a. **Top Solid Layer:** Maximum is 30, minimum is 1.
b. **Bottom Solid Layer:** Maximum is 30, minimum is 1.

- **Infill**
  - **Fill Density** means fill rate.
  - **Fill Pattern** is the pattern of filling shape which effects printing duration.
  - **Combine Infill:** You can select the layers for combining according to the layer thickness. The combined thickness should not exceed 0.4mm. “Every N layers” is for all the infills while “Every N inner layers” is only for inner infills, which generally can save print time.

- **Speed**
  - **Print Speed** is the moving speed of the extruder. Generally, the lower the speed is, the better print you will get. For PLA printing, 80 mm/s is recommended.
  - **Travel Speed** is to control the moving speed of the extruder under non-printing Status during work. For PLA printing, 100 is recommended.

**Note:** Modify parameters settings to get better prints as different models need different parameters.

- **Temperature**
  - **Extruder Temperature:** Recommended extruder temperature is 220°C.

**Note:** Different temperatures have subtle influences in prints. Please adjust the temperature according to the condition in order to get a good print.

- **Others**
  - **Pause At Heights:** Allows users to pre-set a height in which the print will suspend automatically. The function usually applied when you want to change the filament at a certain point. Click [Edit], then you can add or remove a height.

6.2.11 File Menus

① **New Project**

Click [File]--[New Project] can build a blank project. If there is an unsaved modification on previous project, then it will inform you whether the modification
needs to be saved or not. Click [Yes] will save the modification, while click [No] will abandon it. If click [Cancel] or close tool tip, then will cancel the new project.

②Saving
After finishing the model edit and adjustment, there are two ways below to save all models in the scene.

Method 1:
Click [File]-->[Save Project] in the menu bar to save the file as a project file with the “.fpp” suffix, all models in the scene (include support) are independent. After reloading the files, extruder configuration information and model position will be the same as the configuration during saving.

Method 2:
Click on [File]-->[Save as...] to save the model as project file .fpp or .stl and .obj. For .stl and .boj, models are integrated as one (include support part). If load it again, only the position of the model is saved, not include the printing parameters.

③ Preferences
Click [File]-->[Preferences], you can choose language and if needs detecting update when start

- **Language:** The software supports six languages, namely, Chinese (simplified Chinese and traditional Chinese), English, French, Korean, Japanese and Russian.
● **Font Size**: Set the font size.

● **Auto layout newly-imported model**: Set Yes or No.

● **Printing Window Type**: Including Basic Mode and Expert Mode

● **Check for Update after start up**: It is used to preset if it is necessary to activate the online automatic update function, if choose yes, every time when you open software, it can online detect if it is a new version software, once new version found, it will reminds users to download and install new version firmware.

### 6.2.12 Edit Menus

①**Undo**

Allows users to undo the recent edits by the following two methods:

**Method 1**: Click [Edit]—[Undo].

**Method 2**: Press the shortcut Ctrl+Z.

② **Redo**

Allow users to redo the most recent edit you have undone to your model file by the following two methods:

**Method 1**: Click [Edit]—[Redo]

**Method 2**: Press the shortcut Ctrl+Y.

③ **Empty Undo-stack**

To clean up the recorded operating steps so as to release the memory.

④ **Select All**

By the following two methods, you could select all models in the scene. (When models are too small to be seen or out of viewing scope, please click [Center] and [Scale] buttons to adjust the model.)

**Method 1**: Click [Edit]—[Select All].

**Method 2**: Press the shortcut Ctrl+A.

⑤ **Duplicate**
Select the object and duplicate the object through the following two methods:

**Method 1:** Click [Edit]--[Duplicate]

**Method 2:** Press the shortcut Ctrl+D

⑥ **Delete**

Select the object and delete the object through the following two methods:

**Method 1:** Click [Edit]--[Delete]

**Method 2:** Press the shortcut Delete

⑦ **Auto Layout All**

Click [Edit]--[Auto Layout All] after loading one or more than one models, all models will be placed automatically as automatic placement rule.

⑧ **Repair Models**

Click [Edit]--[Repair Models] to repair models.

⑨ **Supports**

Click [Edit]--[Supports] to enter supports setting interface.
6.2.13 Print Menus

1. Connect Machine
You can connect the Inventor 2S with your PC via a USB cable or WiFi.

Note: The machine icon on the bottom right displays the connection status:

Connected

Disconnected

Method 1: Connect Via USB Cable
a. Connect your Inventor 2S with your PC via an USB cable.
b. Turn on your Inventor 2S and start FlashPrint.
c. Click [Print]–[Connect Machine], then select USB in the [Connection Mode] option and select machine you want to connect in [Select Machine] option. If you can not find your machine, click the [Rescan] button to scan your machine and select it. Finally click [Connect] button to connect to the printer. If you still can not find your machine after rescan, it means you haven’t installed the driver in the software.
Method 2: Connect Via WiFi

①Connect Inventor 2S with your PC under AP mode

a. Turn on your Inventor 2S

b. Tap [Tools]-[Setting]-[W Lan hotspot]-[W Lan hotspot ON].

c. Click on the wireless network setting in your computer, and find the wireless signal—“Inventor 2”. Click [Connect] to connect your computer with Inventor 2S via W lan hotspot.

d. Click [Print]-[Connect Machine] on FlashPrint. Then the following dialog box pops up. You need to select “Wi-Fi” in Connect Mode. **Enter into the IP Address shown on the interface and then click [Connect].** 10.10.100.254:8899 may not be the correct IP address according to your printer present status.

If successfully connected, you will see the following red mark.

②Connect Inventor 2S with your PC under STA mode

a. Tap [Tools]-[Setting]-[WiFi]-[WiFi ON] to turn on the WiFi of Inventor 2S and connect your computer and Inventor 2S with the same WiFi signal.

b. Click [Print]-[Connect Machine] on FlashPrint. Then the following dialog box pops up. You need to select “Wi-Fi” in Connect Mode. **Enter into the IP Address shown on the interface and then click [Connect].** 10.10.100.254:8899 may not be the correct IP address according to your printer present status.
If successfully connected, you will see the following red mark.

Disconnect Inventor 2S
Click [Print]--[Disconnect] to disconnect your PC and InventorIIS.

6.2.14 Tool Menus
①Control Panel
After connecting PC with InventorIIS, click [Tools]--[Control Panel] to open the control panel.
● Jog Controls

a. **Jog Mode:** Select the distance that extruder/build plate move a single time (that is, the distance extruder/build plate move upon your single click).

b. **Six blue arrow direction buttons:** Control the move along X/Y/Z axis. X/Y axis button control extruder move, Z axis button control build plate move. Click X-, extruder will move leftward a specified distance; Click X+, extruder will move a specified distance rightward. Click Y-, extruder will move forward a specified distance; Click Y-, extruder will move backward a specified distance. Click Z-, build plate will move upward a specified distance; Click Z-, build plate will move downward a specified distance. (Specified distance refers to the move distance you set in Jog Mode.

c. **Stop:** Click the [Stop] button to abort the current movement.

d. **XYZ coordinate frame on the right side:** Show the current position of extruder/build plate.

e. **Make Current Position Zero button:** Set the current position of the extruder/build plate as (0, 0, 0). (NOTE: X, Y, and Z boxes are for display purposes. Changing the value in the boxes will not affect anything.

f. **Center X/Y/Z button:** Extruder and build platform will back to the zero (0, 0, 0) you set last time.

g. **X/Y Speed and Z Speed:** Set the move speed of extruder/build platform.

● **Limit Switch:** In order to protect your Inventor 2S, three limit switches are equipped to control the maximum position, and the three limit switches corresponding to X/Y/Z axis limit switch. It has two statuses:

a. **Not Triggered:** If the extruder/build plate don’t move to its maximum, X/Y/Z axis limit switch is not triggered, and shows “Not Triggered”.

b. **Triggered:** If the extruder/build plate moves to its maximum, X/Y/Z axis limit switch is triggered, and shows “Triggered”.

www.flashforge-usa.com
● **Stepper Motor Controls:** Allows users to control the stepper motor. Click [Enable], and lock the motor so it does not allow any movement; click [Disable], and unlock the motor to be controlled manually.

● **LED Color:** Allow users to change the LED color of Inventor II S.

● **Extruder Controls:** You can set the value of “Motor Speed (RPM)”, which can control the rotation speed of filament feeding wheel. The motor rotation time can be controlled via setting the value of “Extruder Duration”. Generally we suggest the users choose option of continuous time 60 seconds. The filament must be loaded in the extruder before motor starts. Therefore, do not start rotation operation until the extruder temperature reaches to the printing temperature of filament. For PLA filament, the extruder temperature should reach 200°C, after reaching the extruder temperature, click the [Forward]/[Reverse] rotation button to control filament load and filament unload. Furthermore, if you want to stop filament load and unload, you can click [Stop].

● **Temperature Control:** Input the temperature you want to get in the left frame, click [Apply], the printer will automatically heat the corresponding part, the right side shows the current actual temperature of corresponding part. After starting heating, the below curve of temperature form will start to change, different color correspond different parts’ temperatures

**2. Update Firmware**

Every time when you start FlashPrint, it will automatically detect and download the up-to-date firmware. If any update is available, a dialog box will pop up for reminding the users to update.

**Step 1:** Click [Tools]--[Update firmware]. It needs to cut off connection before updating firmware. If software and printer are already in connection, it reminds you cutting off the connection, and then choose [Yes] and go on to the next step.
Step 2: Choose corresponding printer type and firmware version and click [OK] in the firmware updating box. After confirming the printer is in free state, the software will automatically update the firmware.

Step 3: Reboot you Inventor 2S and wait for 4-5 seconds, then you can see the update process bar. When the update finishes, it will go back to the main interface.

Step 4: Tap [Tools]--[About] to check whether the updated version is right.

③ On Board Preferences
When the computer and printer are in connection, click [Tools]--[On Board Preferences], you can check the printer name.

④ Machine information
When the computer and printer are in connection state, click [Tools]--[Machine information], you can check the machine type, machine name and firmware etc.
6.2.15 Help Menus

① First Run Wizard

② Help Contents:  Click [Help]→[Help Contents], you can read the help contents.

③ Check for Updates:  Click [Help]→[Check for Update] to detect the available updates online.

④ About FlashPrint:  Click [Help]→[About FlashPrint], the software information box will pop up. The contents include the current software version and copyright information.
Chapter 7: Basic Printing

This chapter will provide a step-by-step guide on turning a 3D model into a physical reality. Before proceeding, it is recommended that you’d better go over prior chapters on loading/unloading filament, leveling the build platform, and the functions and capabilities of FlashPrint.

7.1 Generate a Gcode

(7-1) Double-click the icon of FlashPrint to start the software.

(7-2) Click [Print]--[Machine Type] to select FlashForge Inventor 2

(7-3) Click the [Load] icon to load a .stl model file and the object will display on the build area.

(7-4) Click [Edit]--[Surface to Platform] to make your model perfectly positioned on the build area. Click [Back] and double-click the Move icon again, then click [On
the Platform] and [Center] to ensure the model be on the platform.

Note: If you’ve place your model in a right place, you can skip the step above.

(7-5) Click the [Print] icon on the top, you should make some setups for your print job.

Preview: If you check the [Preview] box, you can preview your model after slicing is done.

Print When Slice Done: If you print via USB cable, you can check the box, while if
you print via USB stick, you should not check the box.

**Machine Type:** FlashForge Inventor 2S

**Supports:** If you print a model with supports, you should click the inverted triangle and select [Enable].

**Raft:** You are suggested to select [Enable].

**Resolution:** You are suggested to select [Standard]

**More Options:** You are suggested to keep them default.

Click [OK] to select the path to save the Gcode file. You can rename the file as you like and save it as a .g or .gx file, click [Save] to generate a Gcode file.

**Note:** .gx files are available for preview while the .g files are not. They are displaying as follows:

![File Preview](image)

Next, we are going to print the model.

**7.2 Print Methods**

After generating the Gcode file, you can transfer it to your Inventor 2S. You can transfer the file through USB cable, USB stick, WiFi, FlashForge Cloud and Polar 3D Cloud.

**7.2.1 Print from Computer (USB connection)**

① Connect your Inventor 2S with your PC via a USB cable.
② Turn on your Inventor 2S, level the build plate and load the filament.
③ Click [Print] and transfer your Gcode file to your Inventor 2S. After
completing transference, the printer will heat up automatically. And when heating finishes, the print will start to build the model.

④ When your PC connects with FlashPrint successfully. The status box on the bottom right displays the real-time nozzle temperature. After finishing preheating, your Inventor 2S starts the print job directly.

### 7.2.2 Print from Computer (WiFi connection)

① Connect your Inventor 2S with your PC via WiFi. (Please refer to 6.1.13)

② Turn on your Inventor 2S, level the build plate and load the filament.

③ Click [Print] and transfer your Gcode file to your Inventor 2S. After completing transference, the printer will heat up automatically. And when heating finishes, the printer will start to build the model.

If you want to print a Gcode from a local folder, you just need to load the file into FlashPrint at the status of USB connection or WiFi connection, then click the [Print] button on the top-right.

- Load the target Gcode file into FlashPrint.
• Click the [Print] button, the PC will transfer the Gcode file to the printer.

• After finishing transferring, the printer will heat up automatically. And when heating finishes, the print will start to build the model.
7.2.3 Print from USB Stick

①Insert your USB stick with target .g or .gx file to your Inventor 2S.
②Turn on the Inventor 2S. Make sure the build plate has been leveled and the filament is loaded.
③Tap [Print] and then tap the USB icon in the middle. The file(s) will be displayed on the screen. Select the file you want to print and tap [Print]. The file will be transferred to the printer.
④And the printer will heat up the nozzle automatically and start to print after the nozzle reaches the aimed temperature.,

Abort: To stop heating and printing. Once you tap [Abort], the process is irreversible.

Pause: To suspend the print job, you can tap it again to resume it. You can use this function when you want to change the filament halfway.
7.2.4 Print from FlashForge Cloud connection
1) Turn on [WiFi] connection on printer’s setting interface to connect the printer to Internet with WiFi. Turn on [FlashForge Cloud] connection on printer’s setting interface.
2) Register a FlashForge Cloud account with your computer, on website: https://cloud.sz3dp.com/

3) Register your account on FlashForge cloud: After activate your account through your email box, login in FlashForge cloud with your account.

4) After login in cloud with your own account, click[My printer]—click[Add printer]. Input your Printer's Name and Flashcloud Registration Code in [Add printer] interface. Printer's Name is edit and input by yourself, it can help you identify printer type, user name or using date. Registration Code is showed in your printer's [About] interface.
5) Add a printer completed as showed in the picture below.
More than one of the FlashForge printers can be added to a FlashForge Cloud account,
FlashForge Finder, Inventor 2/Inventor 2S, Adventurer3 printers all support
FlashForge Cloud connection. Using FlashForge Cloud connection print, printers and
print jobs management can be done in batches.

6) Choose a model from cloud model library or upload your own model(stl file),
click[Print], enter the edit model interface to edit model.
7) Select the printer for this print job on left upper position, Click [Print].
Click [Start] to start printing, the selected printer will start printing automatically.
Time remaining for this print job, instant extruder/buildplate temperature or other
printing details are all showed in this webpage, you can also pause or cancel this print
job anytime during printing process.

8) After Inventor 2S printer has added to FlashForge Cloud account and connected
successfully (Inventor 2S printer and your computer should link to Internet by WiFi,
printer and computer do not need to connect the same WiFi signal), Then Inventor 2S
printer’s camera can be used to monitor the real-time printing status.
(This function 8 is valid for now or later.)
7.2.5 Print from Polar Cloud connection

1) Register a Polar Cloud account with your computer, on website:

https://polar3d.com/

Register your account using one of the four following options, take the third microsoft live option as an example, create your new Polar Cloud account.

2) Enter the Polar Cloud homepage after you create your Polar Cloud account. Tap the red icon (on the right upper corner showed in the picture below), then Tap [settings], drag down the page to bottom, copy down your Email address and your PIN Code.
Connect the printer to internet with WiFi; Tap [Tools]-[Settings]-[Polar Cloud connection] on printer’s touch screen; Input your polar 3D cloud account’s Email address(as Account) and PIN Code, Tap[save].
3) Enter the Polar Cloud homepage with your computer again. Tap [Explore] on the left upper corner showed in the picture below, then Tap [Objects]

Enter the objects page, choose a model you are going to print.

Tap 【3D PRINT】 button
Tap 【PRINT】 button

Tap 【START】 button, the printer starts downloading printing file automatically, after downloading completed, you can interactively operate the printer on your computer, including Change Filament, Pause, Stop etc.

4) More than one of the Flashforge printers can be added to a Polar 3D Cloud account, Flashforge Guider 2/Guider 2S, Finder, Inventor 2/Inventor 2S, Adventurer 3 printers all support Polar 3D Cloud connection. After added to Cloud account and connected successfully, Inventor 2S or Guider 2S printer’s camera can be used to monitor the real-time printing status, as showed in the picture below:
5) By using Polar3D Cloud platform, you can create G-CODE printing job by uploading your own sliced print files. Print files can be transferred to corresponding printer and printing will be started automatically. You can also adjust the extruder temperature, or explore other cloud functions.

6) Delete a printer from a polar cloud account.(If someone else wants to use the same printer under another polar cloud account, please make sure you’ve delete the printer from your current-using polar cloud account, or others can not use the printer.)
Click the printer you want to delete.

Click [MANAGE] button on the right upper position of this printer’s details webpage.

Then click [SETTINGS] button on the right upper position of the next webpage.

Finally, drag the next page to bottom down, click [DELETE PRINTER] button. After you’ve completed the above delete steps, this printer can now be used by others under his own polar cloud account.
7.3 Camera
7.3.1 Connect from Polar Cloud
For detailed connection method, please refer to 7.2.5
After Inventor 2S printer has added to Polar Cloud account and connected successfully (Inventor 2S printer and your computer should link to Internet by WiFi, printer and computer do not need to connect the same WiFi signal), Then Inventor 2S printer's camera can be used to monitor the real-time printing status.
This function is valid in FlashForge Cloud for now or later: please refer to 7.2.4 After Inventor 2S printer has added to FlashForge Cloud account and connected successfully (Inventor 2S printer and your computer should link to Internet by WiFi, printer and computer do not need to connect the same WiFi signal), Then Inventor 2S printer’s camera can be used to monitor the real-time printing status.

7.3.2 Direct Connect from computer

1) Connect your Inventor 2S printer and your computer to a same WIFI signal.
2) Install and start up Firefox browser (software) on your computer, type in the following address as the format showed below, then you can monitor the real-time printing status by the camera.


( 192.168.1.111 is your printer’s present IP address, this address must be edited according to your printer IP address showed on printer touch screen.)
Chapter 8: Supports and Service

FlashForge team is on standby and ready to help you with any challenges you may have with your Inventor 2S. If the issues or questions are not covered in this User Guide, you can seek for solutions on our official website or contact us via telephone. There are solutions and instructions to common issues that can be found in our knowledge base. Have a look first as most basic questions are answered there.

http://www.flashforge-usa.com

The FlashForge support team can be reached by e-mail or phone between the working hours of 9:00 a.m. to 5:00 p.m. (PST), Monday - Friday. In case you contact us during off-duty time, your inquiry will be answered the following business day.

Note: Because of changing different filament the extruder maybe blockaded. It’s not owing to quality issue, and outside the scope of 400 hours life. If users encounter this problem, please contact our after-sale department and finish clean work according to their instruction.

Tel:  (626) 322-3855
Email:  supports@flashforge-usa.com
ADD:  17747 Railroad St, City Of Industry, CA  91748, United States

*When contacting support, please have your serial number ready. The serial number is a bar code on the back of your Inventor 2S.*